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Q.1 A shopkeeper sells an item for ₹652.8 after giving two successive discounts of 52% and
80% on its marked price. Had he not given any discount, he would have earned a profit
of 25%. What is the cost price (in ₹) of the item?

Ans A. 5440

B. 5453

C. 5478

D. 5394

Question Type : MCQ
Question ID : 441009915810
Option 1 ID : 4410093617491
Option 2 ID : 4410093617492
Option 3 ID : 4410093617494
Option 4 ID : 4410093617493

Status : Answered
Chosen Option : A

Q.2 A can complete a task in 15 days, and B can complete the same task in 10 days. If they
work together, how much of the task can they complete in 3 days?4181

Ans A.  part

B.  part

C. part

D.  part

Question Type : MCQ
Question ID : 441009897494
Option 1 ID : 4410093544048
Option 2 ID : 4410093544049
Option 3 ID : 4410093544046
Option 4 ID : 4410093544047

Status : Answered
Chosen Option : A

Q.3 If 5 kg of rice costs ₹260, what is the cost of 7.75 kg of rice?

Ans A. ₹403

B. ₹403.50

C. ₹402

D. ₹400.50

Question Type : MCQ
Question ID : 4410091593756
Option 1 ID : 4410096295352
Option 2 ID : 4410096295353
Option 3 ID : 4410096295351
Option 4 ID : 4410096295350

Status : Answered
Chosen Option : A
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Q.4 The least common multiple (LCM) of the numbers 12, 6.1 and 0.25 is:

Ans A. 732

B. 1464

C. 1098

D. 366

Question Type : MCQ
Question ID : 441009525187
Option 1 ID : 4410092056167
Option 2 ID : 4410092056170
Option 3 ID : 4410092056168
Option 4 ID : 4410092056169

Status : Answered
Chosen Option : A

Q.5 A boat covers 72 km downstream in 8 hours and 45 km upstream in 9 hours. After this
journey, the speed of the boat in still water is increased by 5 km/hr, and the speed of
the stream is increased by 2 km/hr. With these new speeds, how much total time will be
taken by the boat to make a trip consisting of 108 km downstream and 54 km
upstream?

Ans A. 13.5 hours

B. 13.2 hours

C. 13.7 hours

D. 13.8 hours

Question Type : MCQ
Question ID : 4410091233328
Option 1 ID : 4410094867012
Option 2 ID : 4410094867013
Option 3 ID : 4410094867011
Option 4 ID : 4410094867010

Status : Answered
Chosen Option : A

 

Q.6

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009620633
Option 1 ID : 4410092436667
Option 2 ID : 4410092436664
Option 3 ID : 4410092436665
Option 4 ID : 4410092436666

Status : Not Answered
Chosen Option : --
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Q.7 A sum of ₹1,25,000 will become ₹1,55,000 in 48 months at certain rate of simple
interest. Find the rate of interest per annum.7031

Ans A. 8%

B. 7%

C. 5%

D. 6%

Question Type : MCQ
Question ID : 441009900344
Option 1 ID : 4410093555447
Option 2 ID : 4410093555449
Option 3 ID : 4410093555446
Option 4 ID : 4410093555448

Status : Answered
Chosen Option : D

Q.8 Find the negative root of 3x2 - 2x - 5 = 0

Ans A. -1.5

B. -2

C. -1

D. -2.5

Question Type : MCQ
Question ID : 4410091226695
Option 1 ID : 4410094840264
Option 2 ID : 4410094840265
Option 3 ID : 4410094840263
Option 4 ID : 4410094840266

Status : Answered
Chosen Option : C

Q.9 Pipe A can fill a tank in 17 hours, pipe B can fill the same tank in 26 hours, and pipe C
can fill the same tank in 12 hours. The time taken by them (in hours) to fill the same
tank, if they operate together, is:

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009278025
Option 1 ID : 4410091080059
Option 2 ID : 4410091080062
Option 3 ID : 4410091080060
Option 4 ID : 4410091080061

Status : Answered
Chosen Option : A
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Q.1
0

A bag contain 50 paisa coins, 25 paisa coins and a rupee coins in the ratio of 7:5:3,
amounting to ₹465. Find the total number of 50 paisa and 25 paisa coins in the bag.

Ans A. 680 coins

B. 720 coins

C. 620 coins

D. 540 coins

Question Type : MCQ
Question ID : 4410091434366
Option 1 ID : 4410095666021
Option 2 ID : 4410095666022
Option 3 ID : 4410095666020
Option 4 ID : 4410095666019

Status : Answered
Chosen Option : B

Q.1
1

Find the value of the digit x for which the six-digit number x7346x is divisible by 18.

Ans A. 6

B. 4

C. 2

D. 8

Question Type : MCQ
Question ID : 441009273082
Option 1 ID : 4410091060877
Option 2 ID : 4410091060875
Option 3 ID : 4410091060876
Option 4 ID : 4410091060878

Status : Answered
Chosen Option : D

Q.1
2

A shopkeeper sells one set of LED TV at ₹12,500 and gains 25%. The cost price price of
TV is:

Ans A. ₹10,000

B. ₹11,000

C. ₹9,000

D. ₹12,000

Question Type : MCQ
Question ID : 4410091428670
Option 1 ID : 4410095643208
Option 2 ID : 4410095643209
Option 3 ID : 4410095643207
Option 4 ID : 4410095643210

Status : Answered
Chosen Option : A
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Q.1
3

96% of the population of a village is 23,520. The total population of the village is:

Ans A. 32,756

B. 26,140

C. 24,500

D. 25,436

Question Type : MCQ
Question ID : 441009857536
Option 1 ID : 4410093383119
Option 2 ID : 4410093383118
Option 3 ID : 4410093383116
Option 4 ID : 4410093383117

Status : Answered
Chosen Option : C

Q.1
4

An isosceles triangle ABC has AB = 4 units and BC = 7 units. Triangle DEF is congruent
to the triangle ABC and its area is more than 13 square units. The length (in units) of
the perpendicular to side AB is:

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009599988
Option 1 ID : 4410092355071
Option 2 ID : 4410092355070
Option 3 ID : 4410092355072
Option 4 ID : 4410092355069

Status : Not Answered
Chosen Option : --

Q.1
5

Find the arithmetic mean of the following data:
Class mark 5 10 12 8 6

Frequency 4 3 6 5 2

Ans A. 8.7

B. 6.4

C. 5.6

D. 7.8

Question Type : MCQ
Question ID : 4410091836807
Option 1 ID : 4410097240865
Option 2 ID : 4410097240863
Option 3 ID : 4410097240862
Option 4 ID : 4410097240864

Status : Answered
Chosen Option : A
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Q.1
6

In a business, A and C invested amounts in the ratio 5:2, whereas A and B invested
amounts in the ratio 4:7. If their annual profit is ₹3,17,016, then A's share in the profit (in
₹) is:

Ans A. 1,12,921

B. 1,00,640

C. 1,00,768

D. 1,15,225

Question Type : MCQ
Question ID : 441009896514
Option 1 ID : 4410093540128
Option 2 ID : 4410093540126
Option 3 ID : 4410093540127
Option 4 ID : 4410093540129

Status : Answered
Chosen Option : B

Q.1
7

The average weight (in kg) of a family of five members whose weights are 40 kg, 49 kg,
57 kg, 67 kg and 38 kg is:

Ans A. 49.2

B. 52.2

C. 51.2

D. 50.2

Question Type : MCQ
Question ID : 441009272598
Option 1 ID : 4410091058941
Option 2 ID : 4410091058942
Option 3 ID : 4410091058940
Option 4 ID : 4410091058939

Status : Answered
Chosen Option : D

Q.1
8

Two items have a cost price of ₹80 each. One is sold at a profit of 12.5%, while the other
is sold at a loss of 12.5%. Determine the overall gain or loss.

Ans A. Neither loss nor gain

B. ₹6.25 gain

C. ₹56.25 gain

D. ₹56.25 loss

Question Type : MCQ
Question ID : 4410091509234
Option 1 ID : 4410095961607
Option 2 ID : 4410095961606
Option 3 ID : 4410095961605
Option 4 ID : 4410095961604

Status : Answered
Chosen Option : A

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.1
9

Two trains, Train A and Train B, are moving on parallel tracks in the same direction.
Train A is 180 meters long and travels at a speed of 54 km/hr. Train B is 120 metres long
and travels at a speed of 72 km/hr. How long will it take for Train B to completely
overtake Train A?

Ans A. 18 seconds

B. 60 seconds

C. 24 seconds

D. 12 seconds

Question Type : MCQ
Question ID : 441009211879
Option 1 ID : 441009831979
Option 2 ID : 441009831982
Option 3 ID : 441009831981
Option 4 ID : 441009831980

Status : Answered
Chosen Option : B

Q.2
0

Rupesh has two grandsons Mandar and Ketan. 14-year-old Mandar gets some money
from Rupesh’s wealth and 15-year-old Ketan gets rest of the money. But Mandar and
Ketan will get money only when they turn 24 years old. Till then the money is in a bank
getting interest at rate 8% compounded annually. When both turn 24, they receive the
same amount. How much had Rupesh given Ketan (in ₹) initially, if total money with
Rupesh was ₹24,700?10105

Ans A. 12,825

B. 11,875

C. 11,625

D. 13,175

Question Type : MCQ
Question ID : 441009573679
Option 1 ID : 4410092249836
Option 2 ID : 4410092249837
Option 3 ID : 4410092249839
Option 4 ID : 4410092249838

Status : Not Answered
Chosen Option : --

Q.2
1

The tomb of Muḥammad Quṭb Shah, the sixth ruler of the Quṭb Shāhī dynasty, is
located in which of the following places?

Ans A. Delhi

B. Hyderabad

C. Bengaluru

D. Agra

Question Type : MCQ
Question ID : 441009892464
Option 1 ID : 4410093523931
Option 2 ID : 4410093523932
Option 3 ID : 4410093523933
Option 4 ID : 4410093523930

Status : Not Answered
Chosen Option : --

Section : General Studies
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Q.2
2

In February 2026, the Government of Odisha proposed the "Subhadra Shakti Samvad"
platform. What is the primary objective of this initiative?

Ans A. To provide interest-free loans to women entrepreneurs

B. To share experiences, raise concerns, and address grievances

C. To provide free medical insurance to all women

D. To organize state-level sports competitions for women

Question Type : MCQ
Question ID : 4410091848875
Option 1 ID : 4410097287734
Option 2 ID : 4410097287732
Option 3 ID : 4410097287731
Option 4 ID : 4410097287733

Status : Answered
Chosen Option : D

List I (Animal) List II (Alternative name)
1. Bharal A. Tibetan wild ass
2. Kiang B. Kashmiri stag
3. Hangul C. Wild goat
4. Markhor D. Blue sheep

Q.2
3

Match the following animals with their respective alternative names.

Ans A. 1-D, 2-C, 3-B, 4-A

B. 1-D, 2-A, 3-B, 4-C

C. 1-B, 2-A, 3-D, 4-C

D. 1-A, 2-D, 3-C, 4-B

Question Type : MCQ
Question ID : 4410091128029
Option 1 ID : 4410094447670
Option 2 ID : 4410094447668
Option 3 ID : 4410094447671
Option 4 ID : 4410094447669

Status : Not Answered
Chosen Option : --

Q.2
4

The Tarapur Rebellion was related to which of the following regions of India?

Ans A. Patna

B. Cooch Behar

C. Awadh

D. Bastar

Question Type : MCQ
Question ID : 441009831593
Option 1 ID : 4410093279458
Option 2 ID : 4410093279460
Option 3 ID : 4410093279457
Option 4 ID : 4410093279459

Status : Not Answered
Chosen Option : --
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Q.2
5

What is the new formula in the school education system in India as proposed by the
new education policy of 2020?

Ans A. 5+ 5+ 2

B. 10+2

C. 5+3+3+4

D. 2+ 4+4+2

Question Type : MCQ
Question ID : 441009510817
Option 1 ID : 4410091998428
Option 2 ID : 4410091998426
Option 3 ID : 4410091998427
Option 4 ID : 4410091998429

Status : Answered
Chosen Option : C

Q.2
6

Who is the author of the book 'The Sari Eternal', which was launched in January 2026?

Ans A. Lakshmi Murdeshwar Puri

B. Shashi Tharoor

C. Sudha Murty

D. Arundhati Roy

Question Type : MCQ
Question ID : 4410091806015
Option 1 ID : 4410097120723
Option 2 ID : 4410097120722
Option 3 ID : 4410097120724
Option 4 ID : 4410097120725

Status : Answered
Chosen Option : D

Q.2
7

In which of the following years was the Census Act enacted in India?

Ans A. 1950

B. 1952

C. 1951

D. 1948

Question Type : MCQ
Question ID : 441009638901
Option 1 ID : 4410092509748
Option 2 ID : 4410092509750
Option 3 ID : 4410092509749
Option 4 ID : 4410092509747

Status : Not Attempted and
Marked For Review

Chosen Option : --
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Q.2
8

In which of the following years did Mahatma Gandhi first visit Odisha?

Ans A. 1921

B. 1935

C. 1919

D. 1942

Question Type : MCQ
Question ID : 441009641259
Option 1 ID : 4410092519172
Option 2 ID : 4410092519173
Option 3 ID : 4410092519171
Option 4 ID : 4410092519174

Status : Answered
Chosen Option : A

Q.2
9

In August 2025, at the 2025 World Games in Chengdu, India achieved its best-ever haul
with how many medals?

Ans A. Three golds

B. One silver and two bronzes

C. Two golds

D. One gold and one silver

Question Type : MCQ
Question ID : 4410091469557
Option 1 ID : 4410095806193
Option 2 ID : 4410095806191
Option 3 ID : 4410095806192
Option 4 ID : 4410095806190

Status : Not Answered
Chosen Option : --

Q.3
0

Which phrase in the Preamble of the Indian Constitution directly indicates that the
ultimate authority to enact and adopt the Constitution lies with the citizens?

Ans A. Sovereign, Socialist, Secular, Democratic Republic

B. Justice, Liberty, Equality, and Fraternity

C. Sarva Dharma Samabhava

D. We, the People of India

Question Type : MCQ
Question ID : 4410091842400
Option 1 ID : 4410097262614
Option 2 ID : 4410097262615
Option 3 ID : 4410097262616
Option 4 ID : 4410097262613

Status : Answered
Chosen Option : D
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Q.3
1

In July 2025, the Odisha government announced upgrading which city to become the
sixth municipal corporation of the state?

Ans A. Rourkela

B. Puri

C. Bhubaneswar

D. Berhampur

Question Type : MCQ
Question ID : 4410091472627
Option 1 ID : 4410095818374
Option 2 ID : 4410095818373
Option 3 ID : 4410095818375
Option 4 ID : 4410095818376

Status : Answered
Chosen Option : B

Q.3
2

Which of the following is recognised as the highest mountain peak in the world?

Ans A. Mount Everest

B. Mount Elbrus

C. Mount Kilimanjaro

D. Mount K2

Question Type : MCQ
Question ID : 4410091460293
Option 1 ID : 4410095769346
Option 2 ID : 4410095769348
Option 3 ID : 4410095769345
Option 4 ID : 4410095769347

Status : Answered
Chosen Option : A

Q.3
3

​​​​​​Which former Chief Minister, known for their long-standing role in Indian politics, was
posthumously honoured with the Padma Vibhushan in 2026?

Ans A. V. S. Achuthanandan

B. J. Jayalalithaa

C. Manohar Parrikar

D. Shibu Soren

Question Type : MCQ
Question ID : 4410091834154
Option 1 ID : 4410097230497
Option 2 ID : 4410097230499
Option 3 ID : 4410097230498
Option 4 ID : 4410097230496

Status : Answered
Chosen Option : A
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Q.3
4

Which of the following best describes the main components of an ecosystem?

Ans A. Only living organisms like plants and animals that depend on each other for survival

B. Only decomposers that recycle nutrients back into the soil

C. Both biotic and abiotic components interacting together

D. Only non-living things like soil, air, water, and sunlight present in the environment

Question Type : MCQ
Question ID : 4410091454429
Option 1 ID : 4410095746021
Option 2 ID : 4410095746024
Option 3 ID : 4410095746023
Option 4 ID : 4410095746022

Status : Answered
Chosen Option : C

Q.3
5

Which of the following is the only major port in Odisha and is a deep-water, all-weather
port located at the confluence of the Mahanadi river and the Bay of Bengal?

Ans A. Paradip Port

B. Chandbali Port

C. Gopalpur Port

D. Dhamra Port

Question Type : MCQ
Question ID : 4410091424546
Option 1 ID : 4410095627037
Option 2 ID : 4410095627038
Option 3 ID : 4410095627036
Option 4 ID : 4410095627035

Status : Answered
Chosen Option : A

Q.3
6

Paradip Port plays a vital role in the development of which industrial corridor in
Odisha?

Ans A. Paradip–Keonjhar–Barbil Mineral Belt

B. Eastern Coastal Corridor

C. Paradip–Haridaspur Industrial Corridor

D. Odisha–Jharkhand Steel Corridor

Question Type : MCQ
Question ID : 441009905243
Option 1 ID : 4410093574793
Option 2 ID : 4410093574790
Option 3 ID : 4410093574792
Option 4 ID : 4410093574791

Status : Answered
Chosen Option : A
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Q.3
7

Based on the intensity of the earthquake, which seismic zone represents the 'Highest
Damage Risk' region in India?

Ans A. Zone II

B. Zone III

C. Zone I

D. Zone V

Question Type : MCQ
Question ID : 44100923234
Option 1 ID : 44100992677
Option 2 ID : 44100992676
Option 3 ID : 44100992674
Option 4 ID : 44100992675

Status : Answered
Chosen Option : D

Q.3
8

A person requires a corrective lens of focal length -50 cm for distant vision and +20 cm
for near vision. What is the nature of the primary defects this person suffers from, and
what is the required power for the near vision correction?

Ans A. Hypermetropia and Myopia, +5.0 D

B. Myopia and Presbyopia, +5.0 D

C. Myopia and Presbyopia, +2.0 D

D. Presbyopia and Myopia, -2.0 D

Question Type : MCQ
Question ID : 4410091424736
Option 1 ID : 4410095627800
Option 2 ID : 4410095627802
Option 3 ID : 4410095627799
Option 4 ID : 4410095627801

Status : Not Answered
Chosen Option : --

Q.3
9

Who among the following established the Indian Association?

Ans A. Bal Gangadhar Tilak

B. Gopal Krishna Gokhale

C. Dadabhai Naoroji

D. Surendranath Banerjee

Question Type : MCQ
Question ID : 4410091068685
Option 1 ID : 4410094220243
Option 2 ID : 4410094220242
Option 3 ID : 4410094220240
Option 4 ID : 4410094220241

Status : Answered
Chosen Option : D
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Q.4
0

Which of the following best describes anodising of aluminium?

Ans A. Forming a thick protective oxide layer on aluminium

B. Polishing aluminium to shine

C. Alloying aluminium with copper

D. Coating aluminium with paint

Question Type : MCQ
Question ID : 4410091432286
Option 1 ID : 4410095657478
Option 2 ID : 4410095657481
Option 3 ID : 4410095657480
Option 4 ID : 4410095657479

Status : Answered
Chosen Option : A

Q.4
1

Which classical dance form originated in Kerala and is known for elaborate makeup
and storytelling through facial expressions and hand gestures?

Ans A. Manipuri

B. Mohiniyattam

C. Sattriya

D. Kathakali

Question Type : MCQ
Question ID : 441009321722
Option 1 ID : 4410091253103
Option 2 ID : 4410091253102
Option 3 ID : 4410091253104
Option 4 ID : 4410091253101

Status : Answered
Chosen Option : D

Q.4
2

In which year was the Odisha government's "Niramaya" free drug distribution scheme
officially launched?

Ans A. 2015

B. 2010

C. 2017

D. 2019

Question Type : MCQ
Question ID : 4410091424063
Option 1 ID : 4410095625042
Option 2 ID : 4410095625041
Option 3 ID : 4410095625043
Option 4 ID : 4410095625044

Status : Not Answered
Chosen Option : --
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Q.4
3

Which of the given defence achievements placed India among a select group of nations
with advanced missile propulsion technology in 2026?

Ans A. Development of indigenous aircraft carrier propulsion system

B. Successful test of Solid Fuel Ducted Ramjet technology

C. Launch of nuclear-powered submarine under foreign program

D. Induction of imported long-range hypersonic missile system

Question Type : MCQ
Question ID : 4410091835739
Option 1 ID : 4410097236686
Option 2 ID : 4410097236687
Option 3 ID : 4410097236689
Option 4 ID : 4410097236688

Status : Answered
Chosen Option : A

Q.4
4

The Third Schedule of the Constitution of India does NOT deal with the oath and
affirmations of which of the following?

Ans A. The President of India

B. The Prime Minister and Council of Ministers

C. The Comptroller and Audit General of India

D. The Judges of the Supreme Court

Question Type : MCQ
Question ID : 44100947052
Option 1 ID : 441009187328
Option 2 ID : 441009187327
Option 3 ID : 441009187330
Option 4 ID : 441009187329

Status : Answered
Chosen Option : C

Q.4
5

The Directive Principles of the State Policy in the Indian Constitution are borrowed
from the Constitution of which country?

Ans A. Germany

B. Ireland

C. Canada

D. Great Britain

Question Type : MCQ
Question ID : 441009501292
Option 1 ID : 4410091960338
Option 2 ID : 4410091960339
Option 3 ID : 4410091960340
Option 4 ID : 4410091960341

Status : Answered
Chosen Option : B

Section : English
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Q.4
6

Choose the correct meaning of the given proverb/idiom.

Have your cake and eat it too

Ans A. People often regret wasting their resources on unnecessary luxuries.

B. Success usually comes only to those who are willing to make sacrifices.

C. It is unrealistic to demand both the highest quality and the lowest cost simultaneously.

D. One cannot expect to enjoy two desirable but contradictory advantages at the same
time.

Question Type : MCQ
Question ID : 441009411369
Option 1 ID : 4410091610866
Option 2 ID : 4410091610867
Option 3 ID : 4410091610869
Option 4 ID : 4410091610868

Status : Answered
Chosen Option : B

Q.4
7

Identify the antonym of the underlined word in the sentence.

The scientist presented a meticulous report on the experiment’s findings.

Ans A. theoretical

B. brief

C. complex

D. careless

Question Type : MCQ
Question ID : 4410091831351
Option 1 ID : 4410097219302
Option 2 ID : 4410097219299
Option 3 ID : 4410097219300
Option 4 ID : 4410097219301

Status : Answered
Chosen Option : D

Q.4
8

Identify the sentence with incorrect conjunctions usage.

Ans A. Rahul arrived late for the meeting as it was raining heavily.

B. Despite the threat from President Donald Trump, NATO nations refused to support
America in the war.

C. She is adored by everyone because she is very polite and humble.

D. He is intelligent because he sometimes makes careless mistakes.

Question Type : MCQ
Question ID : 4410091622569
Option 1 ID : 4410096409054
Option 2 ID : 4410096409055
Option 3 ID : 4410096409053
Option 4 ID : 4410096409052

Status : Answered
Chosen Option : D
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Q.4
9

Select the correct synonym of the highlighted word in the given sentence.

Minor arguments concerned modernity rather than problems of taste.450

Ans A. remarkable

B. prediction

C. contention

D. admiration

Question Type : MCQ
Question ID : 441009823615
Option 1 ID : 4410093248546
Option 2 ID : 4410093248548
Option 3 ID : 4410093248549
Option 4 ID : 4410093248547

Status : Answered
Chosen Option : C

Q.5
0

Identify the error in the given sentence.

(A) The committee's final ruling / (B) neither endorsed the proposal / (C) submitted by
the board / (D) or the amended version.

Ans A. The committee's final ruling

B. neither endorsed the proposal

C. or the amended version.

D. submitted by the board

Question Type : MCQ
Question ID : 4410091848467
Option 1 ID : 4410097286129
Option 2 ID : 4410097286130
Option 3 ID : 4410097286132
Option 4 ID : 4410097286131

Status : Answered
Chosen Option : C

Q.5
1

Choose the correct option to substitute the underlined words in the sentence.
The new girl admitted to our class this session is able to perform many different kinds
of tasks.

Ans A. vulnerable

B. careless

C. volatile

D. versatile

Question Type : MCQ
Question ID : 4410091830324
Option 1 ID : 4410097215283
Option 2 ID : 4410097215284
Option 3 ID : 4410097215286
Option 4 ID : 4410097215285

Status : Answered
Chosen Option : D
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Q.5
2

A statement is divided into different segments. Rearrange all the segments to form a
coherent statement.

(A) of each chapter by next week
(B) they are reading a book
(C) asked them to write a summary
(D) about animals, and the teacher

Ans A. CBAD

B. DBCA

C. ABCD

D. BDCA

Question Type : MCQ
Question ID : 4410091825189
Option 1 ID : 4410097195069
Option 2 ID : 4410097195067
Option 3 ID : 4410097195068
Option 4 ID : 4410097195070

Status : Answered
Chosen Option : D

Q.5
3

Choose the correct form of the tense to complete the sentence.
The witnesses often ______ nervous before the cross-examination.

Ans A. feels

B. has felt

C. feel

D. are feeling

Question Type : MCQ
Question ID : 4410091456315
Option 1 ID : 4410095753607
Option 2 ID : 4410095753609
Option 3 ID : 4410095753606
Option 4 ID : 4410095753608

Status : Answered
Chosen Option : C

Q.5
4

Select the most appropriate option to substitute the underlined word segment in the
given sentence.

She didn't want to waste time on minor issues, so she didn't exaggerate the small
problems.

Ans A. didn't let the cat out of the bag

B. didn't judge the book by its cover

C. didn't make a mountain out of a molehill

D. didn't pull all the eggs in one basket

Question Type : MCQ
Question ID : 4410091822983
Option 1 ID : 4410097186755
Option 2 ID : 4410097186753
Option 3 ID : 4410097186752
Option 4 ID : 4410097186754

Status : Answered
Chosen Option : C
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Q.5
5

Choose the correct indirect speech form for the given sentence.

Direct Speech:
The teacher said, “Do you understand the lesson?”

Ans A. The teacher asked do I understand the lesson.

B. The teacher asked whether I understood the lesson.

C. The teacher said that I understood the lesson.

D. The teacher said if I understand the lesson.

Question Type : MCQ
Question ID : 4410091825634
Option 1 ID : 4410097196824
Option 2 ID : 4410097196823
Option 3 ID : 4410097196825
Option 4 ID : 4410097196822

Status : Answered
Chosen Option : B

Q.5
6

Select the most appropriate option from the given alternatives to fill in the blank.
She _________ her research by next month if everything goes as planned.

Ans A. has completed

B. will be completed

C. will have completed

D. will complete

Question Type : MCQ
Question ID : 4410091822839
Option 1 ID : 4410097186183
Option 2 ID : 4410097186181
Option 3 ID : 4410097186180
Option 4 ID : 4410097186182

Status : Answered
Chosen Option : C

Q.5
7

Out of the four alternatives, choose the one that can be used as a substitute for the
bracketed word segment.

(A class of people holding high social rank and privileges) often had significant
influence over politics and society.

Ans A. Aristocracy

B. Democracy

C. Oligarchy

D. Autocracy

Question Type : MCQ
Question ID : 4410091831559
Option 1 ID : 4410097220160
Option 2 ID : 4410097220161
Option 3 ID : 4410097220159
Option 4 ID : 4410097220162

Status : Answered
Chosen Option : A
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Q.5
8

Select the option that identifies an error in the sentence and provides its correct
replacement.

I walk every evening to shed weight and follow a proper diet towards improved physical
fitness.

Ans A. Replace “physical fitness” with “physically fitness”

B. Replace “to shed weight” with “help shed weight”

C. Replace “diet towards improved” with “diet for improved”

D. Replace “I walk every evening” with “I walk each evening”

Question Type : MCQ
Question ID : 4410091830416
Option 1 ID : 4410097215646
Option 2 ID : 4410097215644
Option 3 ID : 4410097215645
Option 4 ID : 4410097215643

Status : Answered
Chosen Option : C

Q.5
9

Choose the most suitable option to substitute the underlined words in the sentence.

Due to her shy and introverted nature, the new student failed to contribute to or even
attend any school events.

Ans A. relaxed

B. radiant

C. reckless

D. reserved

Question Type : MCQ
Question ID : 4410091830329
Option 1 ID : 4410097215303
Option 2 ID : 4410097215305
Option 3 ID : 4410097215304
Option 4 ID : 4410097215306

Status : Answered
Chosen Option : D

Q.6
0

Choose the sentence with the correct passive voice usage.

Ans A. The secret code was hide beneath the floorboards by the spy.

B. The trophy will being presented to the winner by the principal.

C. The parcel has been delivered to its owner by the boy.

D. A new bridge is being building across the river by the engineers.

Question Type : MCQ
Question ID : 4410091834731
Option 1 ID : 4410097232769
Option 2 ID : 4410097232770
Option 3 ID : 4410097232768
Option 4 ID : 4410097232771

Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage carefully and answer the questions that follow.

In modern life, many people try to perform several tasks at the same time. This practice, known
as multitasking, has become common with the use of smartphones, computers, and other
digital devices. For example, a person may reply to messages while listening to music or
working on a computer. Some people believe that multitasking helps them complete more work
in less time. Multitasking can sometimes be useful, especially when tasks are simple and do
not require much attention. However, research shows that the human brain cannot focus fully
on many complex tasks at once. When people try to divide their attention between several
activities, they may make more mistakes and take longer to finish their work. Therefore, while
multitasking may seem efficient, it can reduce concentration and productivity in certain
situations. Understanding its benefits and risks can help individuals decide when it is better to
focus on one task at a time.

SubQuestion No : 61

Q.6
1

Which of the following is the most appropriate title for the passage?

Ans A. The Development of Human Intelligence

B. The Benefits and Risks of Multitasking

C. The Limitations of Human Concentration

D. The Benefits and Risks of Digital Technology

Question Type : MCQ
Question ID : 4410091822019
Option 1 ID : 4410097183012
Option 2 ID : 4410097183013
Option 3 ID : 4410097183014
Option 4 ID : 4410097183015

Status : Answered
Chosen Option : B

Comprehension:

Read the given passage carefully and answer the questions that follow.

In modern life, many people try to perform several tasks at the same time. This practice, known
as multitasking, has become common with the use of smartphones, computers, and other
digital devices. For example, a person may reply to messages while listening to music or
working on a computer. Some people believe that multitasking helps them complete more work
in less time. Multitasking can sometimes be useful, especially when tasks are simple and do
not require much attention. However, research shows that the human brain cannot focus fully
on many complex tasks at once. When people try to divide their attention between several
activities, they may make more mistakes and take longer to finish their work. Therefore, while
multitasking may seem efficient, it can reduce concentration and productivity in certain
situations. Understanding its benefits and risks can help individuals decide when it is better to
focus on one task at a time.

SubQuestion No : 62

Q.6
2

According to the passage, when can multitasking sometimes be useful?

Ans A. When tasks require deep thinking

B. When tasks require little attention

C. When several people work together

D. When people work in noisy environments

Question Type : MCQ
Question ID : 4410091822020
Option 1 ID : 4410097183016
Option 2 ID : 4410097183017
Option 3 ID : 4410097183018
Option 4 ID : 4410097183019

Status : Answered
Chosen Option : B
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Comprehension:

Read the given passage carefully and answer the questions that follow.

In modern life, many people try to perform several tasks at the same time. This practice, known
as multitasking, has become common with the use of smartphones, computers, and other
digital devices. For example, a person may reply to messages while listening to music or
working on a computer. Some people believe that multitasking helps them complete more work
in less time. Multitasking can sometimes be useful, especially when tasks are simple and do
not require much attention. However, research shows that the human brain cannot focus fully
on many complex tasks at once. When people try to divide their attention between several
activities, they may make more mistakes and take longer to finish their work. Therefore, while
multitasking may seem efficient, it can reduce concentration and productivity in certain
situations. Understanding its benefits and risks can help individuals decide when it is better to
focus on one task at a time.

SubQuestion No : 63

Q.6
3

What does the passage imply about the common belief that multitasking saves time?

Ans A. It may appear useful but is not always effective.

B. It is supported by most psychological research.

C. It is scientifically proven to increase efficiency.

D. It is relevant mainly in academic environments.

Question Type : MCQ
Question ID : 4410091822021
Option 1 ID : 4410097183022
Option 2 ID : 4410097183021
Option 3 ID : 4410097183020
Option 4 ID : 4410097183023

Status : Answered
Chosen Option : A

Comprehension:

Read the given passage carefully and answer the questions that follow.

In modern life, many people try to perform several tasks at the same time. This practice, known
as multitasking, has become common with the use of smartphones, computers, and other
digital devices. For example, a person may reply to messages while listening to music or
working on a computer. Some people believe that multitasking helps them complete more work
in less time. Multitasking can sometimes be useful, especially when tasks are simple and do
not require much attention. However, research shows that the human brain cannot focus fully
on many complex tasks at once. When people try to divide their attention between several
activities, they may make more mistakes and take longer to finish their work. Therefore, while
multitasking may seem efficient, it can reduce concentration and productivity in certain
situations. Understanding its benefits and risks can help individuals decide when it is better to
focus on one task at a time.

SubQuestion No : 64

Q.6
4

Which of the following is the antonym of the word "efficient" as used in the passage?

Ans A. Organised

B. Consistent

C. Useless

D. Productive

Question Type : MCQ
Question ID : 4410091822022
Option 1 ID : 4410097183024
Option 2 ID : 4410097183027
Option 3 ID : 4410097183025
Option 4 ID : 4410097183026

Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage carefully and answer the questions that follow.

In modern life, many people try to perform several tasks at the same time. This practice, known
as multitasking, has become common with the use of smartphones, computers, and other
digital devices. For example, a person may reply to messages while listening to music or
working on a computer. Some people believe that multitasking helps them complete more work
in less time. Multitasking can sometimes be useful, especially when tasks are simple and do
not require much attention. However, research shows that the human brain cannot focus fully
on many complex tasks at once. When people try to divide their attention between several
activities, they may make more mistakes and take longer to finish their work. Therefore, while
multitasking may seem efficient, it can reduce concentration and productivity in certain
situations. Understanding its benefits and risks can help individuals decide when it is better to
focus on one task at a time.

SubQuestion No : 65

Q.6
5

What is the author’s tone in the passage?

Ans A. Humorous

B. Informative

C. Emotional

D. Sarcastic

Question Type : MCQ
Question ID : 4410091822023
Option 1 ID : 4410097183028
Option 2 ID : 4410097183031
Option 3 ID : 4410097183030
Option 4 ID : 4410097183029

Status : Answered
Chosen Option : B

Q.6
6

ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।
ପ୍ରଧାନମନ୍ତ୍ରୀ ଆଜି ଆମେରିକା ଗସ୍ତରେ ଯିବେ।

Ans A. The Prime Minister has gone for a visit to America today.

B. The Prime Minister was leaving for America today.

C. The Prime Minister will leave for America today.

D. The Prime Minister may leave for America today.

Question Type : MCQ
Question ID : 4410091231112
Option 1 ID : 4410094857929
Option 2 ID : 4410094857928
Option 3 ID : 4410094857927
Option 4 ID : 4410094857926

Status : Answered
Chosen Option : C

Section : Odia
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Q.6
7

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଅନୁଦାର

Ans A. ଦାନୀ

B. ସହନଶୀଳ

C. ନିଷ୍ଠା

D. ଉଦାର

Question Type : MCQ
Question ID : 4410091675998
Option 1 ID : 4410096612812
Option 2 ID : 4410096612814
Option 3 ID : 4410096612815
Option 4 ID : 4410096612813

Status : Answered
Chosen Option : D

Q.6
8

ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

He did it as I told him.

Ans A. ମୁଁ  ତାଙ୍କୁ ଯାହା କହିଥି ଲି, ସେ ତାହା କରିଛନ୍ତି।

B. ମୁଁ  ତାଙ୍କୁ ଯେପରି କହିଥି ଲି, ସେ ସେହିପରି କଲେ।

C. ମୁଁ  ତାଙ୍କୁ ଯେପରି କହିଛି, ସେ ସେହିପରି କରୁ ଛନ୍ତି।

D. ମୁଁ  ତାଙ୍କୁ ଯେପରି କହିବି, ସେ ସେହିପରି କରିବେ।

Question Type : MCQ
Question ID : 4410091235100
Option 1 ID : 4410094874141
Option 2 ID : 4410094874138
Option 3 ID : 4410094874140
Option 4 ID : 4410094874139

Status : Answered
Chosen Option : B

Q.6
9

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଢିପ

Ans A. ଚଟାଣ

B. ସମତଳ

C. ପଥୁରିଆ

D. ଖାଲ

Question Type : MCQ
Question ID : 4410091676072
Option 1 ID : 4410096613109
Option 2 ID : 4410096613108
Option 3 ID : 4410096613110
Option 4 ID : 4410096613111

Status : Answered
Chosen Option : A

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.7
0

“ଜୋଇଁ ” ଶବ୍ଦଟି କେଉଁ  ପ୍ରକାରର ଶବ୍ଦ?

Ans A. ଦେଶଜ

B. ତଦ୍ଭବ

C. ବୈଦେଶିକ

D. ତତ୍ସମ

Question Type : MCQ
Question ID : 4410091235940
Option 1 ID : 4410094877347
Option 2 ID : 4410094877349
Option 3 ID : 4410094877348
Option 4 ID : 4410094877346

Status : Not Answered
Chosen Option : --

Q.7
1

ମୋ ବାପା ଜଣେ ______ ବ୍ୟକ୍ତି  ।

Ans A. ସଚ୍ଚୋଟ

B. ସମ୍ମାନ

C. ସଚ୍ଚୋଟତା

D. ସରଳତା

Question Type : MCQ
Question ID : 4410091675833
Option 1 ID : 4410096612165
Option 2 ID : 4410096612167
Option 3 ID : 4410096612164
Option 4 ID : 4410096612166

Status : Answered
Chosen Option : A

Q.7
2

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଆଖି

Ans A. କର୍ଣ୍ଣ

B. ହସ୍ତ

C. ଚଷମା

D. ଚକ୍ଷୁ

Question Type : MCQ
Question ID : 4410091199579
Option 1 ID : 4410094732133
Option 2 ID : 4410094732132
Option 3 ID : 4410094732135
Option 4 ID : 4410094732134

Status : Answered
Chosen Option : D
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Q.7
3

ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।

କାଲି ଆମେ ବାଙ୍ଗାଲୋର ଯିବାକୁ ଯୋଜନା କରିଛୁ।

Ans A. We are going to Bangalore tomorrow.

B. We will plan to go to Bangalore tomorrow.

C. We have planned to go to Bangalore.

D. We have planned to go to Bangalore tomorrow.

Question Type : MCQ
Question ID : 4410091232792
Option 1 ID : 4410094864855
Option 2 ID : 4410094864853
Option 3 ID : 4410094864854
Option 4 ID : 4410094864852

Status : Answered
Chosen Option : D

Q.7
4

ସେ ଏମିତି ______ ଗାଇଲା ଯେ କରତାଳି ଦ୍ଵାରା ସମସ୍ତେ ତାକୁ ଅଭିବାଦନ କଲେ ।

Ans A. ଧୀରେ

B. ଅଳ୍ପ

C. ସୁନ୍ଦର ଭାବରେ

D. ଜୋରେ

Question Type : MCQ
Question ID : 4410091675717
Option 1 ID : 4410096611698
Option 2 ID : 4410096611699
Option 3 ID : 4410096611696
Option 4 ID : 4410096611697

Status : Answered
Chosen Option : C

Q.7
5

ତୁ ମେ ମୋତେ ଡାକିବା ସମୟରେ ମୁଁ  ଟିଭି  ______।

Ans A. ଦେଖି ବି

B. ଦେଖୁଥି ଲି

C. ଦେଖୁଥି ଲେ

D. ଦେଖି ଲି

Question Type : MCQ
Question ID : 4410091675637
Option 1 ID : 4410096611378
Option 2 ID : 4410096611377
Option 3 ID : 4410096611379
Option 4 ID : 4410096611376

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସେଣ୍ଟ୍ରାଲ ଆମେରିକାର ସୁବହୃତ ଜଙ୍ଗଲାଞ୍ଚଳ ବିଲୁପ୍ତ ହୋଇଯାଉଥି ବା ଯୋଗୁଁ  ସେଠାକାର ପରିବେଶ ଦୁର୍ଗତିର ସମ୍ମୁଖୀନ
ହେବା ସଙ୍ଗେ ସଙ୍ଗେ ସମଗ୍ର ମାନବଜାତି ମଧ୍ଯ ବିପୁଳ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେଉଛି। ଏଠାକାର ସମୃଦ୍ଧ ଜୈବିକ ବିଭିନ୍ନତା ଅନେକ
ପ୍ରକାର ଅନୁବଂଶିକ ଉତ୍ସ ଧାରଣ କରିଛି । ଏଗୁଡ଼ିକୁ କୃଷି, ଶିଳ୍ପ ଓ ଚିକିତ୍ସା-ବିଜ୍ଞାନର ସମୃଦ୍ଧି ସାଧନ ଦିଗରେ ନିୟୋଜିତ
କରାଯିବାର ସମ୍ଭାବନାକୁ ଏଡ଼ି ହେଉନାହିଁ। ଉଦାହରଣ ସ୍ୱରୂ ପ, ୧୯୭୮ ମସିହାରେ ଦକ୍ଷିଣ ମେକ୍‌ସିକୋର ଜଙ୍ଗଲରୁ  ଏକ
ପ୍ରକାର ବଣୁଆ ଜାତୀୟ ଖାଦ୍ୟଶସ୍ୟର ସନ୍ଧାନ ମିଳିଲା । ବିଭିନ୍ନ ପ୍ରକାର କଲମି କୌଶଳ ପ୍ରୟୋଗ କରାଯିବା ଫଳରେ ଏଥି ରୁ
ଏପରି ଉତ୍କୃ ଷ୍ଟ ବିହନ ପ୍ରସ୍ତୁତ କରାଗଲା ଫସଲର ପରିମାଣରେ ବୃଦ୍ଧି ଘଟିବା ସଙ୍ଗେ ସଙ୍ଗେ ଉଦ୍ଭିଦଗୁଡ଼ିକ ଜଣାଶୁଣା
ଭାଇରସମାନଙ୍କ ଦ୍ଵାରା ସଂକ୍ରମିତ ହେବାର ଅବକାଶ ରହିଲା ନାହିଁ । ସାଉଥ କାରୋଲିନାର ଡକ୍ଟର ମନି ଏସ୍: ହସେନ ନାମକ
ଜନୈକ ବିଶେଷଜ୍ଞ ସୂଚାଇଛନ୍ତି ଯେ, କୋସ୍ତାରିକାର ଜଙ୍ଗଲାଞ୍ଚଳରେ ଦେଖାଯାଉଥି ବା ପ୍ରାୟ ୧୫୦୦ ପ୍ରକାର ଉଦ୍ଭିଦ ମଧ୍ଯରୁ
ଶତକଡ଼ା ୧୫ ଭାଗ ଉଭିଦରୁ  ଦୁରାରୋଗ୍ୟ କ୍ୟାନ୍‌ସର ବ୍ୟାଧି ର ଉପଶମ ପାଇଁ  ଆବଶ୍ୟକୀୟ ଭେଷଳ ମହୌଷଧ
ମିଳିପାରିବାର ସମ୍ଭାବନା ରହିଅଛି । ଏଣୁ ଆମେ ବୁଝିପାରୁ  ଯେ, ହାମ୍‌ବର୍ଗର ଖାଇବାର ଅଭ୍ୟାସକୁ ବଳବତ୍ତର ରଖିବା ଯୋଗୁଁ
ଉଭୟ ଯୁକ୍ତରାଷ୍ଟ୍ର ଆମେରିକା ଓ ସେଣ୍ଟ୍ରାଲ ଆମେରିକା ଗ୍ରୀଷ୍ମପ୍ରଧାନ ଅଞ୍ଚଳର ଘନଜଙ୍ଗଲରୂ ପୀ ଏକ ଉତ୍ ‌କୃଷ୍ଟ ପରିସଂସ୍ଥାକୁ
ଯେପରି ବିପଦାପନ୍ନ କରୁ ଛନ୍ତି, ସେଥି ପାଇଁ  ଉଭୟ ପକ୍ଷ ଭବିଷ୍ୟତରେ ଦାରୁ ଣ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେବାର ଆଶଙ୍କା ରହିଛି ।
ଏଣୁ ଆସନ୍ନ ସଙ୍କଟ କବଳରୁ  ନିଜ ନିଜକୁ ରକ୍ଷା କରିବା ପାଇଁ  ଉଭୟପକ୍ଷର ସ‌ହଯୋଗିତାମୂଳକ କାର୍ଯ୍ୟାନୁଷ୍ଠା ନ ନିହାତି ଜରୁ ରୀ
ବୋଧ ହେଉଛି।

SubQuestion No : 76

Q.7
6

ଅନୁଚ୍ଛେଦର ଗଢଣ କିପରି?

Ans A. ଅସଙ୍ଗତ

B. ବିବାଦପୂର୍ଣ୍ଣ

C. ଅଧୂରା

D. କ୍ରମବଦ୍ଧ ଓ ବିସ୍ତୃତ

Question Type : MCQ
Question ID : 4410091481996
Option 1 ID : 4410095855013
Option 2 ID : 4410095855015
Option 3 ID : 4410095855014
Option 4 ID : 4410095855012

Status : Answered
Chosen Option : D
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସେଣ୍ଟ୍ରାଲ ଆମେରିକାର ସୁବହୃତ ଜଙ୍ଗଲାଞ୍ଚଳ ବିଲୁପ୍ତ ହୋଇଯାଉଥି ବା ଯୋଗୁଁ  ସେଠାକାର ପରିବେଶ ଦୁର୍ଗତିର ସମ୍ମୁଖୀନ
ହେବା ସଙ୍ଗେ ସଙ୍ଗେ ସମଗ୍ର ମାନବଜାତି ମଧ୍ଯ ବିପୁଳ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେଉଛି। ଏଠାକାର ସମୃଦ୍ଧ ଜୈବିକ ବିଭିନ୍ନତା ଅନେକ
ପ୍ରକାର ଅନୁବଂଶିକ ଉତ୍ସ ଧାରଣ କରିଛି । ଏଗୁଡ଼ିକୁ କୃଷି, ଶିଳ୍ପ ଓ ଚିକିତ୍ସା-ବିଜ୍ଞାନର ସମୃଦ୍ଧି ସାଧନ ଦିଗରେ ନିୟୋଜିତ
କରାଯିବାର ସମ୍ଭାବନାକୁ ଏଡ଼ି ହେଉନାହିଁ। ଉଦାହରଣ ସ୍ୱରୂ ପ, ୧୯୭୮ ମସିହାରେ ଦକ୍ଷିଣ ମେକ୍‌ସିକୋର ଜଙ୍ଗଲରୁ  ଏକ
ପ୍ରକାର ବଣୁଆ ଜାତୀୟ ଖାଦ୍ୟଶସ୍ୟର ସନ୍ଧାନ ମିଳିଲା । ବିଭିନ୍ନ ପ୍ରକାର କଲମି କୌଶଳ ପ୍ରୟୋଗ କରାଯିବା ଫଳରେ ଏଥି ରୁ
ଏପରି ଉତ୍କୃ ଷ୍ଟ ବିହନ ପ୍ରସ୍ତୁତ କରାଗଲା ଫସଲର ପରିମାଣରେ ବୃଦ୍ଧି ଘଟିବା ସଙ୍ଗେ ସଙ୍ଗେ ଉଦ୍ଭିଦଗୁଡ଼ିକ ଜଣାଶୁଣା
ଭାଇରସମାନଙ୍କ ଦ୍ଵାରା ସଂକ୍ରମିତ ହେବାର ଅବକାଶ ରହିଲା ନାହିଁ । ସାଉଥ କାରୋଲିନାର ଡକ୍ଟର ମନି ଏସ୍: ହସେନ ନାମକ
ଜନୈକ ବିଶେଷଜ୍ଞ ସୂଚାଇଛନ୍ତି ଯେ, କୋସ୍ତାରିକାର ଜଙ୍ଗଲାଞ୍ଚଳରେ ଦେଖାଯାଉଥି ବା ପ୍ରାୟ ୧୫୦୦ ପ୍ରକାର ଉଦ୍ଭିଦ ମଧ୍ଯରୁ
ଶତକଡ଼ା ୧୫ ଭାଗ ଉଭିଦରୁ  ଦୁରାରୋଗ୍ୟ କ୍ୟାନ୍‌ସର ବ୍ୟାଧି ର ଉପଶମ ପାଇଁ  ଆବଶ୍ୟକୀୟ ଭେଷଳ ମହୌଷଧ
ମିଳିପାରିବାର ସମ୍ଭାବନା ରହିଅଛି । ଏଣୁ ଆମେ ବୁଝିପାରୁ  ଯେ, ହାମ୍‌ବର୍ଗର ଖାଇବାର ଅଭ୍ୟାସକୁ ବଳବତ୍ତର ରଖିବା ଯୋଗୁଁ
ଉଭୟ ଯୁକ୍ତରାଷ୍ଟ୍ର ଆମେରିକା ଓ ସେଣ୍ଟ୍ରାଲ ଆମେରିକା ଗ୍ରୀଷ୍ମପ୍ରଧାନ ଅଞ୍ଚଳର ଘନଜଙ୍ଗଲରୂ ପୀ ଏକ ଉତ୍ ‌କୃଷ୍ଟ ପରିସଂସ୍ଥାକୁ
ଯେପରି ବିପଦାପନ୍ନ କରୁ ଛନ୍ତି, ସେଥି ପାଇଁ  ଉଭୟ ପକ୍ଷ ଭବିଷ୍ୟତରେ ଦାରୁ ଣ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେବାର ଆଶଙ୍କା ରହିଛି ।
ଏଣୁ ଆସନ୍ନ ସଙ୍କଟ କବଳରୁ  ନିଜ ନିଜକୁ ରକ୍ଷା କରିବା ପାଇଁ  ଉଭୟପକ୍ଷର ସ‌ହଯୋଗିତାମୂଳକ କାର୍ଯ୍ୟାନୁଷ୍ଠା ନ ନିହାତି ଜରୁ ରୀ
ବୋଧ ହେଉଛି।

SubQuestion No : 77

Q.7
7

ଅନୁଚ୍ଛେଦର ଅନୁମାନ କଣ?

Ans A. ଜଙ୍ଗଲ ନଷ୍ଟ ହେଲେ କେବଳ ସେଣ୍ଟ୍ରାଲ ଆମେରିକା ପ୍ରଭାବିତ ହେବ।

B. ସେଣ୍ଟ୍ରାଲ ଆମେରିକାର ଜଙ୍ଗଲ ନଷ୍ଟ ହେଲେ ସମଗ୍ର ମାନବଜାତି କ୍ଷତିଗ୍ରସ୍ତ ହେବ।

C. ଜଙ୍ଗଲ ନଷ୍ଟ ହେଲେ କୌଣସି ପ୍ରଭାବ ନଥାଏ।

D. ମାନବଜାତି ଜଙ୍ଗଲ ସହ ବ୍ୟବହାର କରିବାରେ ଆଗ୍ରହୀ ହେବ।

Question Type : MCQ
Question ID : 4410091481997
Option 1 ID : 4410095855017
Option 2 ID : 4410095855016
Option 3 ID : 4410095855019
Option 4 ID : 4410095855018

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସେଣ୍ଟ୍ରାଲ ଆମେରିକାର ସୁବହୃତ ଜଙ୍ଗଲାଞ୍ଚଳ ବିଲୁପ୍ତ ହୋଇଯାଉଥି ବା ଯୋଗୁଁ  ସେଠାକାର ପରିବେଶ ଦୁର୍ଗତିର ସମ୍ମୁଖୀନ
ହେବା ସଙ୍ଗେ ସଙ୍ଗେ ସମଗ୍ର ମାନବଜାତି ମଧ୍ଯ ବିପୁଳ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେଉଛି। ଏଠାକାର ସମୃଦ୍ଧ ଜୈବିକ ବିଭିନ୍ନତା ଅନେକ
ପ୍ରକାର ଅନୁବଂଶିକ ଉତ୍ସ ଧାରଣ କରିଛି । ଏଗୁଡ଼ିକୁ କୃଷି, ଶିଳ୍ପ ଓ ଚିକିତ୍ସା-ବିଜ୍ଞାନର ସମୃଦ୍ଧି ସାଧନ ଦିଗରେ ନିୟୋଜିତ
କରାଯିବାର ସମ୍ଭାବନାକୁ ଏଡ଼ି ହେଉନାହିଁ। ଉଦାହରଣ ସ୍ୱରୂ ପ, ୧୯୭୮ ମସିହାରେ ଦକ୍ଷିଣ ମେକ୍‌ସିକୋର ଜଙ୍ଗଲରୁ  ଏକ
ପ୍ରକାର ବଣୁଆ ଜାତୀୟ ଖାଦ୍ୟଶସ୍ୟର ସନ୍ଧାନ ମିଳିଲା । ବିଭିନ୍ନ ପ୍ରକାର କଲମି କୌଶଳ ପ୍ରୟୋଗ କରାଯିବା ଫଳରେ ଏଥି ରୁ
ଏପରି ଉତ୍କୃ ଷ୍ଟ ବିହନ ପ୍ରସ୍ତୁତ କରାଗଲା ଫସଲର ପରିମାଣରେ ବୃଦ୍ଧି ଘଟିବା ସଙ୍ଗେ ସଙ୍ଗେ ଉଦ୍ଭିଦଗୁଡ଼ିକ ଜଣାଶୁଣା
ଭାଇରସମାନଙ୍କ ଦ୍ଵାରା ସଂକ୍ରମିତ ହେବାର ଅବକାଶ ରହିଲା ନାହିଁ । ସାଉଥ କାରୋଲିନାର ଡକ୍ଟର ମନି ଏସ୍: ହସେନ ନାମକ
ଜନୈକ ବିଶେଷଜ୍ଞ ସୂଚାଇଛନ୍ତି ଯେ, କୋସ୍ତାରିକାର ଜଙ୍ଗଲାଞ୍ଚଳରେ ଦେଖାଯାଉଥି ବା ପ୍ରାୟ ୧୫୦୦ ପ୍ରକାର ଉଦ୍ଭିଦ ମଧ୍ଯରୁ
ଶତକଡ଼ା ୧୫ ଭାଗ ଉଭିଦରୁ  ଦୁରାରୋଗ୍ୟ କ୍ୟାନ୍‌ସର ବ୍ୟାଧି ର ଉପଶମ ପାଇଁ  ଆବଶ୍ୟକୀୟ ଭେଷଳ ମହୌଷଧ
ମିଳିପାରିବାର ସମ୍ଭାବନା ରହିଅଛି । ଏଣୁ ଆମେ ବୁଝିପାରୁ  ଯେ, ହାମ୍‌ବର୍ଗର ଖାଇବାର ଅଭ୍ୟାସକୁ ବଳବତ୍ତର ରଖିବା ଯୋଗୁଁ
ଉଭୟ ଯୁକ୍ତରାଷ୍ଟ୍ର ଆମେରିକା ଓ ସେଣ୍ଟ୍ରାଲ ଆମେରିକା ଗ୍ରୀଷ୍ମପ୍ରଧାନ ଅଞ୍ଚଳର ଘନଜଙ୍ଗଲରୂ ପୀ ଏକ ଉତ୍ ‌କୃଷ୍ଟ ପରିସଂସ୍ଥାକୁ
ଯେପରି ବିପଦାପନ୍ନ କରୁ ଛନ୍ତି, ସେଥି ପାଇଁ  ଉଭୟ ପକ୍ଷ ଭବିଷ୍ୟତରେ ଦାରୁ ଣ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେବାର ଆଶଙ୍କା ରହିଛି ।
ଏଣୁ ଆସନ୍ନ ସଙ୍କଟ କବଳରୁ  ନିଜ ନିଜକୁ ରକ୍ଷା କରିବା ପାଇଁ  ଉଭୟପକ୍ଷର ସ‌ହଯୋଗିତାମୂଳକ କାର୍ଯ୍ୟାନୁଷ୍ଠା ନ ନିହାତି ଜରୁ ରୀ
ବୋଧ ହେଉଛି।

SubQuestion No : 78

Q.7
8

ଅନୁଚ୍ଛେଦରେ ଦିଆଯାଇଥିବା ଉଦାହରଣ କଣ?

Ans A. ଆମେରିକାର ଜଳସମ୍ପଦ

B. ମହାମାରୀ ସମୟରେ ଦିଆଯାଇଥି ବା ଚିକିତ୍ସା

C. ବିଶ୍ୱ ଯୁଦ୍ଧର ପ୍ରଭାବ

D. ୧୯୭୮ ମସିହାରେ ଦକ୍ଷିଣ ମେକ୍ସିକୋର ଜଙ୍ଗଲରୁ  ଏକ ପ୍ରକାର ବଣୁଆ ଜାତୀୟ ଖାଦ୍ୟଶସ୍ୟର ସନ୍ଧାନ

Question Type : MCQ
Question ID : 4410091481998
Option 1 ID : 4410095855021
Option 2 ID : 4410095855023
Option 3 ID : 4410095855022
Option 4 ID : 4410095855020

Status : Answered
Chosen Option : D
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସେଣ୍ଟ୍ରାଲ ଆମେରିକାର ସୁବହୃତ ଜଙ୍ଗଲାଞ୍ଚଳ ବିଲୁପ୍ତ ହୋଇଯାଉଥି ବା ଯୋଗୁଁ  ସେଠାକାର ପରିବେଶ ଦୁର୍ଗତିର ସମ୍ମୁଖୀନ
ହେବା ସଙ୍ଗେ ସଙ୍ଗେ ସମଗ୍ର ମାନବଜାତି ମଧ୍ଯ ବିପୁଳ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେଉଛି। ଏଠାକାର ସମୃଦ୍ଧ ଜୈବିକ ବିଭିନ୍ନତା ଅନେକ
ପ୍ରକାର ଅନୁବଂଶିକ ଉତ୍ସ ଧାରଣ କରିଛି । ଏଗୁଡ଼ିକୁ କୃଷି, ଶିଳ୍ପ ଓ ଚିକିତ୍ସା-ବିଜ୍ଞାନର ସମୃଦ୍ଧି ସାଧନ ଦିଗରେ ନିୟୋଜିତ
କରାଯିବାର ସମ୍ଭାବନାକୁ ଏଡ଼ି ହେଉନାହିଁ। ଉଦାହରଣ ସ୍ୱରୂ ପ, ୧୯୭୮ ମସିହାରେ ଦକ୍ଷିଣ ମେକ୍‌ସିକୋର ଜଙ୍ଗଲରୁ  ଏକ
ପ୍ରକାର ବଣୁଆ ଜାତୀୟ ଖାଦ୍ୟଶସ୍ୟର ସନ୍ଧାନ ମିଳିଲା । ବିଭିନ୍ନ ପ୍ରକାର କଲମି କୌଶଳ ପ୍ରୟୋଗ କରାଯିବା ଫଳରେ ଏଥି ରୁ
ଏପରି ଉତ୍କୃ ଷ୍ଟ ବିହନ ପ୍ରସ୍ତୁତ କରାଗଲା ଫସଲର ପରିମାଣରେ ବୃଦ୍ଧି ଘଟିବା ସଙ୍ଗେ ସଙ୍ଗେ ଉଦ୍ଭିଦଗୁଡ଼ିକ ଜଣାଶୁଣା
ଭାଇରସମାନଙ୍କ ଦ୍ଵାରା ସଂକ୍ରମିତ ହେବାର ଅବକାଶ ରହିଲା ନାହିଁ । ସାଉଥ କାରୋଲିନାର ଡକ୍ଟର ମନି ଏସ୍: ହସେନ ନାମକ
ଜନୈକ ବିଶେଷଜ୍ଞ ସୂଚାଇଛନ୍ତି ଯେ, କୋସ୍ତାରିକାର ଜଙ୍ଗଲାଞ୍ଚଳରେ ଦେଖାଯାଉଥି ବା ପ୍ରାୟ ୧୫୦୦ ପ୍ରକାର ଉଦ୍ଭିଦ ମଧ୍ଯରୁ
ଶତକଡ଼ା ୧୫ ଭାଗ ଉଭିଦରୁ  ଦୁରାରୋଗ୍ୟ କ୍ୟାନ୍‌ସର ବ୍ୟାଧି ର ଉପଶମ ପାଇଁ  ଆବଶ୍ୟକୀୟ ଭେଷଳ ମହୌଷଧ
ମିଳିପାରିବାର ସମ୍ଭାବନା ରହିଅଛି । ଏଣୁ ଆମେ ବୁଝିପାରୁ  ଯେ, ହାମ୍‌ବର୍ଗର ଖାଇବାର ଅଭ୍ୟାସକୁ ବଳବତ୍ତର ରଖିବା ଯୋଗୁଁ
ଉଭୟ ଯୁକ୍ତରାଷ୍ଟ୍ର ଆମେରିକା ଓ ସେଣ୍ଟ୍ରାଲ ଆମେରିକା ଗ୍ରୀଷ୍ମପ୍ରଧାନ ଅଞ୍ଚଳର ଘନଜଙ୍ଗଲରୂ ପୀ ଏକ ଉତ୍ ‌କୃଷ୍ଟ ପରିସଂସ୍ଥାକୁ
ଯେପରି ବିପଦାପନ୍ନ କରୁ ଛନ୍ତି, ସେଥି ପାଇଁ  ଉଭୟ ପକ୍ଷ ଭବିଷ୍ୟତରେ ଦାରୁ ଣ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେବାର ଆଶଙ୍କା ରହିଛି ।
ଏଣୁ ଆସନ୍ନ ସଙ୍କଟ କବଳରୁ  ନିଜ ନିଜକୁ ରକ୍ଷା କରିବା ପାଇଁ  ଉଭୟପକ୍ଷର ସ‌ହଯୋଗିତାମୂଳକ କାର୍ଯ୍ୟାନୁଷ୍ଠା ନ ନିହାତି ଜରୁ ରୀ
ବୋଧ ହେଉଛି।

SubQuestion No : 79

Q.7
9

ଅନୁଚ୍ଛେଦରେ ବ୍ୟବହୃତ ‘ସହଯୋଗିତା’ ଶବ୍ଦର ବାସ୍ତବ ଜୀବନ ସହିତ ସଂଯୋଗ କ’ଣ?

Ans A. ଜଳସମ୍ପଦ ବିଭାଜନ

B. ଜଙ୍ଗଲ ରକ୍ଷା ପାଇଁ  ଦେଶମାନଙ୍କ ମଧ୍ୟରେ ମିଳିତ ପ୍ରୟାସ

C. ନିଜ ସ୍ୱାର୍ଥ ପାଇଁ  ଦାବି

D. ବ୍ୟକ୍ତିଗତ ଅନ୍ତର୍ଗତ ସଂଘର୍ଷ

Question Type : MCQ
Question ID : 4410091481999
Option 1 ID : 4410095855025
Option 2 ID : 4410095855024
Option 3 ID : 4410095855027
Option 4 ID : 4410095855026

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସେଣ୍ଟ୍ରାଲ ଆମେରିକାର ସୁବହୃତ ଜଙ୍ଗଲାଞ୍ଚଳ ବିଲୁପ୍ତ ହୋଇଯାଉଥି ବା ଯୋଗୁଁ  ସେଠାକାର ପରିବେଶ ଦୁର୍ଗତିର ସମ୍ମୁଖୀନ
ହେବା ସଙ୍ଗେ ସଙ୍ଗେ ସମଗ୍ର ମାନବଜାତି ମଧ୍ଯ ବିପୁଳ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେଉଛି। ଏଠାକାର ସମୃଦ୍ଧ ଜୈବିକ ବିଭିନ୍ନତା ଅନେକ
ପ୍ରକାର ଅନୁବଂଶିକ ଉତ୍ସ ଧାରଣ କରିଛି । ଏଗୁଡ଼ିକୁ କୃଷି, ଶିଳ୍ପ ଓ ଚିକିତ୍ସା-ବିଜ୍ଞାନର ସମୃଦ୍ଧି ସାଧନ ଦିଗରେ ନିୟୋଜିତ
କରାଯିବାର ସମ୍ଭାବନାକୁ ଏଡ଼ି ହେଉନାହିଁ। ଉଦାହରଣ ସ୍ୱରୂ ପ, ୧୯୭୮ ମସିହାରେ ଦକ୍ଷିଣ ମେକ୍‌ସିକୋର ଜଙ୍ଗଲରୁ  ଏକ
ପ୍ରକାର ବଣୁଆ ଜାତୀୟ ଖାଦ୍ୟଶସ୍ୟର ସନ୍ଧାନ ମିଳିଲା । ବିଭିନ୍ନ ପ୍ରକାର କଲମି କୌଶଳ ପ୍ରୟୋଗ କରାଯିବା ଫଳରେ ଏଥି ରୁ
ଏପରି ଉତ୍କୃ ଷ୍ଟ ବିହନ ପ୍ରସ୍ତୁତ କରାଗଲା ଫସଲର ପରିମାଣରେ ବୃଦ୍ଧି ଘଟିବା ସଙ୍ଗେ ସଙ୍ଗେ ଉଦ୍ଭିଦଗୁଡ଼ିକ ଜଣାଶୁଣା
ଭାଇରସମାନଙ୍କ ଦ୍ଵାରା ସଂକ୍ରମିତ ହେବାର ଅବକାଶ ରହିଲା ନାହିଁ । ସାଉଥ କାରୋଲିନାର ଡକ୍ଟର ମନି ଏସ୍: ହସେନ ନାମକ
ଜନୈକ ବିଶେଷଜ୍ଞ ସୂଚାଇଛନ୍ତି ଯେ, କୋସ୍ତାରିକାର ଜଙ୍ଗଲାଞ୍ଚଳରେ ଦେଖାଯାଉଥି ବା ପ୍ରାୟ ୧୫୦୦ ପ୍ରକାର ଉଦ୍ଭିଦ ମଧ୍ଯରୁ
ଶତକଡ଼ା ୧୫ ଭାଗ ଉଭିଦରୁ  ଦୁରାରୋଗ୍ୟ କ୍ୟାନ୍‌ସର ବ୍ୟାଧି ର ଉପଶମ ପାଇଁ  ଆବଶ୍ୟକୀୟ ଭେଷଳ ମହୌଷଧ
ମିଳିପାରିବାର ସମ୍ଭାବନା ରହିଅଛି । ଏଣୁ ଆମେ ବୁଝିପାରୁ  ଯେ, ହାମ୍‌ବର୍ଗର ଖାଇବାର ଅଭ୍ୟାସକୁ ବଳବତ୍ତର ରଖିବା ଯୋଗୁଁ
ଉଭୟ ଯୁକ୍ତରାଷ୍ଟ୍ର ଆମେରିକା ଓ ସେଣ୍ଟ୍ରାଲ ଆମେରିକା ଗ୍ରୀଷ୍ମପ୍ରଧାନ ଅଞ୍ଚଳର ଘନଜଙ୍ଗଲରୂ ପୀ ଏକ ଉତ୍ ‌କୃଷ୍ଟ ପରିସଂସ୍ଥାକୁ
ଯେପରି ବିପଦାପନ୍ନ କରୁ ଛନ୍ତି, ସେଥି ପାଇଁ  ଉଭୟ ପକ୍ଷ ଭବିଷ୍ୟତରେ ଦାରୁ ଣ ଭାବରେ କ୍ଷତିଗ୍ରସ୍ତ ହେବାର ଆଶଙ୍କା ରହିଛି ।
ଏଣୁ ଆସନ୍ନ ସଙ୍କଟ କବଳରୁ  ନିଜ ନିଜକୁ ରକ୍ଷା କରିବା ପାଇଁ  ଉଭୟପକ୍ଷର ସ‌ହଯୋଗିତାମୂଳକ କାର୍ଯ୍ୟାନୁଷ୍ଠା ନ ନିହାତି ଜରୁ ରୀ
ବୋଧ ହେଉଛି।

SubQuestion No : 80

Q.8
0

‘ସମୃଦ୍ଧ’ ଶବ୍ଦର ଅର୍ଥ କ’ଣ?

Ans A. ଜ୍ଞାନୀ

B. ଉନ୍ନତ

C. ବିକାଶ

D. ଶୂନ୍ୟ

Question Type : MCQ
Question ID : 4410091482000
Option 1 ID : 4410095855029
Option 2 ID : 4410095855028
Option 3 ID : 4410095855031
Option 4 ID : 4410095855030

Status : Answered
Chosen Option : C

Q.8
1

Which action performed by mobile security software directly prevents the
execution of applications or files that could compromise the device?

Ans A. Compressing all installed apps

B. Reducing screen brightness

C. Blocking unsafe apps and files

D. Increasing download speed

Question Type : MCQ
Question ID : 4410091453369
Option 1 ID : 4410095741766
Option 2 ID : 4410095741765
Option 3 ID : 4410095741763
Option 4 ID : 4410095741764

Status : Answered
Chosen Option : C
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Q.8
2

Which is the quickest memory among the following?

Ans A. Hard Disk

B. RAM

C. Cache

D. SSD

Question Type : MCQ
Question ID : 4410091420590
Option 1 ID : 4410095611279
Option 2 ID : 4410095611277
Option 3 ID : 4410095611278
Option 4 ID : 4410095611280

Status : Answered
Chosen Option : C

Q.8
3

Which of the following is a volatile memory?

Ans A. CD-ROM

B. RAM

C. ROM

D. Hard Disk

Question Type : MCQ
Question ID : 4410091417913
Option 1 ID : 4410095600576
Option 2 ID : 4410095600575
Option 3 ID : 4410095600573
Option 4 ID : 4410095600574

Status : Answered
Chosen Option : B

Q.8
4

What is the primary function of a Uniform Resource Locator (URL) in the World
Wide Web?

Ans A. To define the protocol, location, and resource path for accessing web content

B. To store website cookies

C. To encrypt website traffic

D. To authenticate user identity

Question Type : MCQ
Question ID : 4410091459615
Option 1 ID : 4410095766624
Option 2 ID : 4410095766623
Option 3 ID : 4410095766625
Option 4 ID : 4410095766626

Status : Answered
Chosen Option : A
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Q.8
5

By default, when you paste content into Microsoft Word 2021 using Ctrl+V, the original
formatting is:

Ans A. Converted to style of destination

B. Removed automatically

C. Preserved

D. Changed to plain text

Question Type : MCQ
Question ID : 4410091450148
Option 1 ID : 4410095729111
Option 2 ID : 4410095729108
Option 3 ID : 4410095729109
Option 4 ID : 4410095729110

Status : Answered
Chosen Option : C

Q.8
6

Which security threat primarily exploits human psychology to compromise Windows 11
or Office 2021 systems?

Ans A. Spyware

B. Phishing

C. Ransomware

D. Trojan

Question Type : MCQ
Question ID : 4410091417126
Option 1 ID : 4410095597434
Option 2 ID : 4410095597431
Option 3 ID : 4410095597432
Option 4 ID : 4410095597433

Status : Answered
Chosen Option : A

Q.8
7

Which of the following statements correctly explains the difference between “Save”
and “Save As” in MS Word?

Ans A. “Save” opens a file, while “Save As” prints it.

B. “Save” updates the existing file, while “Save As” saves it with a new name or location.

C. Both perform identical functions.

D. “Save” closes the file, while “Save As” deletes it.

Question Type : MCQ
Question ID : 4410091416358
Option 1 ID : 4410095594132
Option 2 ID : 4410095594130
Option 3 ID : 4410095594129
Option 4 ID : 4410095594131

Status : Answered
Chosen Option : B
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Q.8
8

Which of the following best defines e-commerce?

Ans A. Financial transactions through banks only

B. Sending goods through electronic mail

C. Buying and selling goods only in physical stores

D. Electronic buying and selling of goods and services over the Internet

Question Type : MCQ
Question ID : 4410091450833
Option 1 ID : 4410095731793
Option 2 ID : 4410095731792
Option 3 ID : 4410095731790
Option 4 ID : 4410095731791

Status : Answered
Chosen Option : D

Q.8
9

In context of Bullets and Numbering(Microsoft Word 2021), match the Actions in
Column A with their correct descriptions in Column B:

Column A Column B
1. Bullets a) Generates a list with consecutive numbers or letters

2. Numbering b) Inserts a graphical symbol before each listed item

3. Multilevel List c) Arranges list items into multiple hierarchical levels

4. Increase Indent d) Shifts the current list item further to the right, creating a sublevel

Ans A. 1-d, 2-c, 3-b, 4-a

B. 1-c, 2-d, 3-a, 4-b

C. 1-a, 2-b, 3-d, 4-c

D. 1-b, 2-a, 3-c, 4-d

Question Type : MCQ
Question ID : 4410091467947
Option 1 ID : 4410095799604
Option 2 ID : 4410095799602
Option 3 ID : 4410095799603
Option 4 ID : 4410095799601

Status : Answered
Chosen Option : D

Q.9
0

The formula in cell E5 is =A5*100. Assuming you are using relative cell references, what
will the formula become when you copy it directly down into cell E6 in Microsoft Excel
2021?

Ans A. =A1*100

B. =E5*100

C. =A6*100

D. =E6*100

Question Type : MCQ
Question ID : 4410091478449
Option 1 ID : 4410095841139
Option 2 ID : 4410095841141
Option 3 ID : 4410095841142
Option 4 ID : 4410095841140

Status : Not Attempted and
Marked For Review

Chosen Option : --
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Q.9
1

Phishing attacks are usually carried out through:

Ans A. Antivirus software

B. Emails and instant messages

C. Operating system updates

D. Physical mail

Question Type : MCQ
Question ID : 4410091448942
Option 1 ID : 4410095724239
Option 2 ID : 4410095724237
Option 3 ID : 4410095724238
Option 4 ID : 4410095724236

Status : Answered
Chosen Option : B

Q.9
2

Which of the following options is used to open an existing spreadsheet in MS
Excel?

Ans A. File → Open

B. File → Save As

C. File → Print

D. File → New

Question Type : MCQ
Question ID : 4410091416439
Option 1 ID : 4410095594490
Option 2 ID : 4410095594489
Option 3 ID : 4410095594492
Option 4 ID : 4410095594491

Status : Answered
Chosen Option : A

Q.9
3

Which menu path correctly opens the dialog box for specifying an exact row height in
Excel 2021?

Ans A. Data → Tools → Adjust Height ​​​​​​

B. Insert → Format → Row Height

C. View → Page Layout → Height

D. Home → Cells → Format → Row Height

Question Type : MCQ
Question ID : 4410091467571
Option 1 ID : 4410095798150
Option 2 ID : 4410095798148
Option 3 ID : 4410095798149
Option 4 ID : 4410095798147

Status : Answered
Chosen Option : B
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Q.9
4

Which of the following is not a common area where computers are used today?

Ans A. Growing crops manually in fields

B. Manufacturing and service industries

C. Education

D. Medicine and health care

Question Type : MCQ
Question ID : 4410091444342
Option 1 ID : 4410095705986
Option 2 ID : 4410095705988
Option 3 ID : 4410095705987
Option 4 ID : 4410095705985

Status : Answered
Chosen Option : A

Q.9
5

When using MS PowerPoint’s “AutoRecover” feature, which of the following
behaviours is correct for a new blank presentation created but never saved?

Ans A. AutoRecover only works for files created from templates, not blank ones.

B. If the file was never saved manually, AutoRecover will store a temporary version but
when you close the app without saving, the file may be lost.

C. AutoRecover will save permanent backups in same folder by default.

D. MS PowerPoint saves the file automatically as a .pptx in the current directory
regardless of user save.

Question Type : MCQ
Question ID : 4410091453367
Option 1 ID : 4410095741758
Option 2 ID : 4410095741756
Option 3 ID : 4410095741755
Option 4 ID : 4410095741757

Status : Answered
Chosen Option : B

Q.9
6

In MS PowerPoint 2021, a presenter can resume a slideshow from where it
was stopped by pressing:

Ans A. Ctrl + F5

B. Alt + F5

C. Shift + F5

D. F5

Question Type : MCQ
Question ID : 4410091435685
Option 1 ID : 4410095671252
Option 2 ID : 4410095671250
Option 3 ID : 4410095671253
Option 4 ID : 4410095671251

Status : Answered
Chosen Option : C
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Q.9
7

In context of viewing a presentation in PowerPoint 2021, match the View Mode in
Column A with its Description in Column B :

Column A – View
Mode Column B – Description

1. Normal View a) Plays the presentation in full-screen mode for delivering to an
audience

2. Slide Sorter View b) Displays small slide previews for quick organization and
rearranging

3. Reading View c) The main editing view that displays slide thumbnails, the
main slide, and notes areas

4. Slide Show View d) Shows the presentation in a window for easy on-screen
viewing without editing

Ans A. 1–c, 2–d, 3–b, 4–a

B. 1–c, 2–b, 3–d, 4–a

C. 1–b, 2–a, 3–c, 4–d

D. 1–d, 2–c, 3–b, 4–a

Question Type : MCQ
Question ID : 4410091471313
Option 1 ID : 4410095813176
Option 2 ID : 4410095813173
Option 3 ID : 4410095813174
Option 4 ID : 4410095813175

Status : Answered
Chosen Option : B

Q.9
8

On Instagram, which of the following emerging features reflects a shift in the platform’s
role from pure photo-sharing to broader content and business-driven ecosystem—and
thus has societal/data-handling implications?

Ans A. Instagram only supports text-based posts with no image or video.

B. Instagram has introduced analytics for business accounts such as “Insights”, and
supports Reels, Shopping integrations and deeper user-behaviour tracking.

C. Instagram disallows any form of commercial activity or user analytics.

D. Instagram continues to have only black-and-white photos and no video support.

Question Type : MCQ
Question ID : 4410091459920
Option 1 ID : 4410095767864
Option 2 ID : 4410095767862
Option 3 ID : 4410095767863
Option 4 ID : 4410095767861

Status : Answered
Chosen Option : B
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Q.9
9

Which component of system software is responsible for initializing hardware and
loading the operating system during boot?

Ans A. BIOS/UEFI

B. Device driver

C. Shell

D. Kernel

Question Type : MCQ
Question ID : 4410091445538
Option 1 ID : 4410095710734
Option 2 ID : 4410095710735
Option 3 ID : 4410095710736
Option 4 ID : 4410095710733

Status : Answered
Chosen Option : A

Q.1
00

Which of the following most accurately describes the role of network segmentation
in a layered network security strategy?

Ans A. It ensures that all network traffic bypasses the firewall for performance reasons.

B. It refers only to physically separating wireless and wired devices with no policy
controls.

C. It merges network zones so all devices share the same security profile.

D. It divides a network into separate, isolated segments so that even if one segment is
compromised, threats cannot easily spread to others — thus reducing the attack surface.

Question Type : MCQ
Question ID : 4410091453574
Option 1 ID : 4410095742594
Option 2 ID : 4410095742592
Option 3 ID : 4410095742591
Option 4 ID : 4410095742593

Status : Answered
Chosen Option : D
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